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Introduction 

Xtreme takes a traditional animator's approach to Flash animation. You create key 

frames (or 'snap-shots') of your animation through time, and Xtreme automatically 

creates all the in-between frames for you. 

 

Xtreme does not have timelines (which is the approach used by the Adobe Flash 

authoring tool). We feel our approach is far simpler. 

 

  

An example start frame 

  

  
The next key frame has the star shape moved, rotated a 

little, reduced in size, and changed to a different color. 

  

 
Xtreme will create a smoothly animated Flash file automatically creating the 

 in-between frames. This process is traditionally called tweening. 

  

What Flash can and cannot do 
The Flash format does not support some of the advanced effects that Xtreme offers, 

for example complex graduated transparency, feathering, bevels and most of the 

advanced color fill types. 

 

However it does support a range of effects that include simple transparency. So, for 

example, if you fade the star on the 2nd key frame above to be 100% transparent, 

you'll get an animation where the star moves, reduces in size and fades. 

  

 
 The same example, with in-between frames, but employing a transparency too. 

Like Xtreme, Flash is vector graphics based which means you can enlarge objects 

with no loss of detail. It also means Flash files can be very compact—which is of 
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course ideal for web download. 

 

To illustrate just how small and compact Xtreme Flash animations can be, the 

previous example animated over one second with 24 frames (so the movie plays at a 

smooth 24 frames per second) creates a Flash file that's only 700 bytes. 

 

The 6 core transformations 
In order to keep Flash files very compact, the types of shape tweening supported by 

Flash is limited to six core transforms: 

1. Move—you can move objects from one position to another. 

2. Scale—you can enlarge or reduce objects in size. 

3. Squash or skew—you can squash or skew objects. 

4. Rotate—you can rotate objects. 

5. Transparency—you can adjust the overall (flat) transparency of the objects. 

6. Color transform—you can change the fill (flat) color of objects. 

  

Note: the above six transform types are absolutely key to all Flash animations. No 

other type of transform is possible for the tweened frames. 

 

If you look at Flash animation examples on the web, you'll find that almost all consist 

of just these effects. Objects fade in and out; they whiz from one position to another. 

They sometimes spin, and often grow or shrink. That's the basis for almost all Flash 

animations, and it's very easy to produce such animations in Xtreme. 

  

One thing that isn‘t possible is to change the shape of an object between key frames. 

  

 
 It’s not possible to change the shape between key frames. 

 

Because the shape changes—i.e. it morphs from one shape to another, this is not 

possible in Xtreme Flash animations. 

  

Important:  tweening is not like the Blend tool, which can 'morph' from one shape 

to another. To stress the point again: the only things you can do to shapes, text and 

photos in Flash animations are the six core transform types listed above. 

 
 

Transforms 1 to 6 

can be applied to 

all vector shapes 

and text, and 1 to 

5 can be applied 

to photos. 
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What you can't do with Xtreme Flash 
Xtreme is primarily a vector illustration package and is not designed to be an all-

encompassing Flash tool. Instead we feel it brings a new, innovative, very easy to 

understand approach to Flash animation. Combined with Xtreme's acclaimed vector 

drawing tools and slick ease-of-use, it allows you to create really compact Flash 

animations more easily than other tools. 

  

Because of this simplified approach, Xtreme does not support more complex Flash 

features such as scripting (programming), audio or embedded movies. 

  

Additionally, as Flash vector rendering is relatively primitive compared to Xara 

Xtreme‘s there are advanced Xtreme effects that cannot be used in Flash. These are 

detailed in the What Xtreme Features Does Flash Support? section towards the end 

of this chapter. 

 

Initial reading 

The main manual contains more information on: 

 The Name gallery—page 39. 

 The Frame gallery—page 203.                   

 Animated GIFs—page 203. 

  

Core principles 

In your animation you are likely to have some objects that remain static between key 

frames (i.e. no tweening is necessary) and other objects you will want to animate.  

 

To tell Xtreme which objects you want to animate it's necessary to give each object 

a name, which is simply done via the Create New Names button on the Selector tool 

InfoBar. 

 

 
 

An overview of the typical process to create a new animation from scratch, which 

this chapter will guide you through, is this: 

1. Draw your first frame. Name the objects that you want to animate.  

2. Create a new key frame, usually done by copying the earlier frame. 

3. Move and transform the objects as required. 

4. Preview the results. 

5. Repeat steps 2 through 4. 

 

And so you can then build up your animation. 

Xtreme provides an easy one-button way to create new key frames which are a 

copy of a previous frame (see left). The Frame gallery allows you to view any key  
The Copy 

Frame button on 

the Animation 

button bar. 
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frame, and you can adjust the frame order and display period for each key frame. The 

Frame gallery is described in depth later in this chapter. 

  

For those familiar with the animated GIF features of Xtreme (or its predecessors) 

the whole process will be very familiar. The difference is that with Flash files Xtreme 

can automatically create all the tween steps, to produce smoother and much more 

compact animations than animated GIFs can offer. 

  

Note: objects that you want to animate from one frame to another need to have a 

name. All other objects will remain visible, but static, for the display period of the 

frame until the next key frame. So to delete an object from an animation, just delete 

it on the first key frame on which you no longer need it to appear. 

 

Your first animation 

To create a new animation: 

1. Create a new animation document. To do this: 

 Choose File > New > Animation (shortcut Ctrl++N). 

 Or click the New Animation button on the Standard button bar. 

 
A new document will open, and you will see the animation button bar 

appear that contains some relevant buttons. 

2. Draw a simple black rectangle (like shown in the examples at the beginning 

of the chapter). Give it no fill color. 

3. Draw a simple shape, such as the QuickShape star (but it can be any shape). 

4. Click the Create New Names icon on the Selector InfoBar and name it 

'shape'. 

 
5. Click the Copy Frame button to create your 2nd key frame. 

 
6. Transform the shape as required. You can adjust it using any of the six core 

transforms described earlier in the chapter. 

7. Press the Preview Flash button to see the animation. 

 
 

By default the display period for each key frame is half a second. To produce a longer 

animation, see the Movie Frame Rate and Tween Steps section later in the chapter. 

  

For more complex animations we strongly recommend you display both the Frame 

and Name galleries (described in depth later in the chapter), which can be docked on 

the side of the Xtreme window for ease of access.  
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You are not limited to just one moving object. You can have as many as you like on 

each key frame. And as long as they appear, transformed in some way, on the next 

key frame (and they are each given a unique name) they will animate. 

  

Here is another example. 

 

 
The first key frame has some simple text and a simple shape within a static rectangle. 

  

 
And this is the next frame, where the text has been reduced in size at the 

same time as the star shape has been reduced, re-colored and rotated. 

  

This is how the animation is constructed. 

 

 
In this animation, the text object recedes into the distance 

while at the same time the star shrinks and fades. 

 

 

Key frame 1 

 

 
 

Intermediate 

tween steps 

produced by 

Xtreme Pro 

 

 

 

 

Key frame 2 
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Exporting a Flash file 

To export your animation as a Flash file: 

 Select File > Export and then choose Flash under Save As Type. 

 Or click the Export Animated Flash button. 

 
 

This will save the finished SWF file into the location you choose. 

 

Inserting your Flash animation into a web page 
To view your animation as it would look in a web page, click the Preview Flash 

button to see a browser preview. 

 
 

The preview page will show your finished animation as well as useful information 

such as the animation‘s dimensions, file size and estimated download times. 

 

To place your SWF animation into a web page you will need to insert some HTML 

code. Click the View HTML link to get code that you can paste into your web page 

using your preferred HTML editor. 

 

Note: you must change the SWF filename in the code to match the actual name of 

your exported SWF file. You must also place your SWF file into the same directory 

as your web page for the code to work. While you can place the SWF file in a 

different directory, you will need to change the HTML code accordingly if you do.  

 

The Frame gallery  

To open the Frame gallery choose Utilities > Galleries > Frame Gallery, or click the 

Frame gallery icon on the Galleries toolbar. 

 
 

This shows a list of the key frames in your document. To view any key frame just 

click its name in the gallery. 
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A typical Frame gallery. Frame 2 is selected and thus visible. 

  

The Frame gallery shows frames from the top down, so the first frame is at the top 

and the each new frame you add gets put at the bottom of the list. You can re-order 

frames by dragging them. There are buttons to perform the main operations of 

deleting frames, copying the selected frame (it will always get added to the end) and 

creating new blank frames. The Properties button is very important as it shows the 

Animation Properties dialog which controls many aspects of not just the selected 

frame but the whole animation. 

 

 
The Animation Properties dialog 

 

The All Frames Visible (the eye) and Edit All Frames (the arrow) buttons on the 

Frame Gallery are useful because they allow you to view or edit all frames together, 

one on top of the other. This is particularly useful if you want to select objects that 

are on multiple frames.  

  

Note: when you copy a frame it always copies the selected frame and places it at 

the end. So in order to insert a new frame, say between frames 4 and 5, select frame 

  

The frame order 

is the reverse of 

that in earlier 

versions of Xara 

Xtreme. 

A shortcut to 

display the 

Animation 

Properties dialog 

is to simply 

double-click on a 

frame name in 

the Frame gallery 
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4, click the Copy button, and then drag the new copy from the end to the desired 

position between frames 4 and 5. 

  

Note: frame names do not matter—and can be anything you like. They do not have 

to be Frame 1, Frame 2 etc. Animations always play the frames in the order top to 

bottom, irrespective of the names. 

 

Copying objects 
You can copy objects from one frame to another in the usual way (i.e. copy the 

content, select the new frame and then paste into the new frame). The Edit > Paste 

in Place option (Ctrl++V) is particularly useful when doing this, as this will always 

paste objects back to the exact position they came from but on the new frame. 

  

When you copy an object its name is copied with it. But be careful not to have more 

than one object with the same name on a given frame. Doing so will generate errors. 
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Photos  

Because Flash files usually consist of vector shapes, and the transforms are relatively 

simple, the files can be very small. Photos and bitmaps can be embedded into Flash 

animations, but unless you are careful it will result in huge animation files. You can 

perform 5 of the 6 core Flash transforms on bitmaps or photos (i.e. you can move, 

scale, squash, rotate, and fade). 

  

Flash files can include both PNG and JPEG images just as .xar files do, and so if you 

keep their size and resolution down you can create acceptably small Flash animations 

with photos. The best way to incorporate photos is to use JPEG images as small as 

you can possibly get away with, and with the maximum compression you can accept. 

  

Fortunately it's easy to save JPEG images from Xtreme, at any size, resolution and 

compression and you even have interactive preview where you can adjust the 

compression and immediately see the result. 

  

If you just drop a JPEG file onto the animation, and resize it, that does not reduce the 

size of the JPEG file—it only reduces the dimensions (and thus increases the 

resolution). Flash is just like Xtreme in this respect—it will embed the original full 

resolution JPEG image, so you can zoom in. So it's easy to estimate the size of any 

animation containing JPEG photos—it's approximately the sum of the sizes of all the 

embedded JPEG images. (The Bitmap gallery will show you the size of all embedded 

photos or bitmaps). 

 

When tweening bitmaps or photos only one copy of the bitmap is stored in the Flash 

file—so you can perform transformations of the bitmap with little overhead. In other 

words just because the bitmap appears on frames 1, 2 and 3 of your animation does 

not mean three copies of the bitmap are embedded in the Flash file. 

  

Producing optimized JPEG photos 
To create a smaller JPEG, it's necessary to export it as a new JPEG from Xtreme at 

the required size and compression value, then re-import the now-reduced JPEG. The 

steps are this: 

1. Drop the required JPEG file onto Xtreme. 

2. Resize it to be the size you require in your animation. 

3. Select File > Export (shortcut Ctrl++E) and export as JPEG. 

4. In the export preview window, select the Options tab and adjust the quality 

slider as low as you can make it. The file size is shown under the preview.  

5. Export the JPEG. 

6. Drag and drop your new mini-sized JPEG from Windows File Explorer back 

onto the animation document where you intend to use it. This JPEG file will 

be embedded into the Flash file (and the .xar file when you save). 
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Non-JPEG bitmaps 
Other types of bitmap, for example, BMP, TIFF or PNG bitmaps, are usually a lot 

larger and thus less suitable for use in Flash animations (JPEG compression is a lot 

better than PNG). Therefore, when creating a Flash animation, these bitmaps get 

converted to JPEG in order to create the smallest possible file size. 

 

You can control the compression used for this automatic JPEG conversion using a 

slider in the Flash Options tab of the Animation Properties dialog. The usual 

compression value is 75%, but you can vary the quality, preview the animation and 

quickly see the quality and size savings. Note: this only affects automatically 

generated JPEG bitmaps. JPEG files that you drop onto your animation from your file 

system, are embedded exactly as is. 

 

256 color or less bitmaps (such as GIF) are not encoded as JPEG and will be 

embedded using PNG compression, which is usually the best compression type for 

these types of images 

 

Bitmap quality 
Flash Player version 8 and later has higher quality bitmap display. This is particular 

evident when rotating or scaling bitmaps and photos whereas older versions of the 

player tend to produce pixelated, and rather jerky movements. 

 

It‘s therefore recommended to export your Flash animation as Version 8 if you‘re 

using bitmaps or photos. You can control this from the Flash Options tab of the 

Animation Properties dialog. 

 

You can tell which 

version of the 

Flash Player you 

have by right 

clicking on any 

Flash animation in 

your web browser 

and looking at the 

About menu. 
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Animation frame rate and tween steps 

Flash animations run at a fixed frame rate. The faster the frame rate the smoother 

the resulting animation, and the larger the Flash file. Xtreme animations default to 

showing 24 frames per second but you can change this. 

  

When you create each key frame you determine how long the period is until the 

next key frame. For example if a frame period is set to half a second, this means the 

animation from that key frame to the next will take half a second. At 24 frames per 

second this means there will be 11 intermediate steps generated by Xtreme in the 

Flash animation, so 12 frames in all. (These intermediate frames are not ever seen in 

Xtreme they are only generated when you create the Flash file.) 

  

 
The Frame gallery always shows you the display period for each key frame. 

In this example three frames are displayed for half a second each, so 

the whole animation lasts 1.5 seconds before repeating. 

 

To create a longer tween effect, in other words to slow the animation down, 

increase the display period using the Animation Properties dialog. 

 

The easiest way to alter the display period for any frame is to just double-click on 

the frame name you want to alter, which brings up the dialog, enter the new period 

in seconds and click OK or Apply. 
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Cropping and clipping 

Before long you'll start to consider creating some Flash animations like you see on 

the web, say with some wording or a photo that whizzes in from one side. 

  

Assuming you want the animation cropped to the frame, how do you do this?  The 

answer is to use ClipViews. (See page 99 of the main manual for help on ClipViews.) 

  

By using a rectangle as a ClipView object it means your animation never strays 

outside the frame. So the half-way point of your animation would look like this: 

 
  

 To create an animation like this: 

1. Create your first frame as before, drawing the rectangle, text and shapes at 

their starting positions (the text and shapes could be entirely outside the 

rectangle frame at the start).  

2. Name the objects you want to animate, in the above case the text and star 

shape.  

3. Make sure the rectangle frame is the back-most object (select the object 

then select Arrange > Put to Back or shortcut Ctrl+B). This is because the 

back-most object is the one that will be used as the clipping shape.  

4. Select all the objects, and select Arrange > Apply ClipView. 

5. Click the Copy Frame button to create your 2nd key frame. 

 
6. Select Arrange > Remove ClipView so you can work on the separate 

objects again.  

7. Adjust the text and star size and position as required.  

8. Select all the objects again, and select Arrange > Apply Clipview. 

9. Press the Preview Flash button to see the animation. 

 
 

Note: if you get a warning telling you that 'non round line joins and end caps' are only 

supported by SWF 8 then you can either ignore it (all line end caps and joins will use 

the round setting—few people will notice) or set the Flash version to use version 8 

from the Animation Properties dialog (click Properties in the Frame gallery). 

  

Although you can use Select Inside (Ctrl+click) to select objects inside a ClipView, 

it's generally easier to remove the ClipView, edit the frame contents as required and 

then Select All and re-apply the ClipView again. Remember that the ClipView object 

is always the back-most object of the selection. 
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Animation speed 

When you create a new key frame it defaults to having a period of half a second. 

So the animation from that key frame to the next will take half a second. The longer 

you set the period the slower the animation. To set the frame period for any frame, 

first select the desired frame in the Frame gallery (click on it) and then click the 

Animation Properties button (or just double-click the frame name). 

 

 
Setting ‘Display This Frame For’ to 2 seconds means the animation 

will take 2 seconds before it gets to the next key frame. 

  

Note: the Animation Properties dialog is non-modal and you can keep this on 

screen all the time. By pressing the Apply button instead of OK, the dialog remains 

on screen. Its contents are updated as you select different frames, and for each of 

them you can set the required display period. 
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Animation smoothness 

Flash movies play at a constant frame rate. The faster the frame rate the smoother 

the animation. Xtreme defaults to showing 24 frames per second. To change the rate 

select the Flash Options tab of the Animation Properties dialog. 

 

 
 The Flash Options tab, where you can change the 

movie speed as well as the Flash export version. 

 

Note: the faster the frame rate the larger the resulting Flash file. You will find that if 

your animation is mostly objects fading in and out with relatively little fast moving 

animation, then you can reduce the frame rate to under 24 frames per second. If you 

have a lot of fast action it may be necessary to increase the frame rate, but it‘s rarely 

necessary to have it above 50 frames per second. 

  

The default movie speed of 24 frames per second ties into the default frame period 

of half a second. It means that, using these defaults, there are exactly 12 frames of 

the movie from one key-frame to the next. 
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Rotation 

Xtreme calculates and generates the tween frames automatically by working out 

how to transform the shapes from one key frame to the next. But sometimes it's not 

possible to know exactly what type of rotation is required.  

 

Take this example. Suppose you tween from the first clock face to the second: 

 

              
 

You might expect it to rotate clockwise, but of course it could go counter clockwise: 

  

            
 

In fact there are other ways it could rotate. The above examples assume the hand 

rotates around one end, but you could tween from one state into the other by doing 

a straight line rotation of the center of the object, which would result in this: 

 

 
 

If you look closely, the hand rotates around its center rather than one end, and the 

center point moves in the straight line from one key frame to the next. By default, 

Xtreme rotates objects this way. 

 

The Rotate command 
To force the rotation to be around any other point you can use a special keyword 
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'rotate' appended to the front of the object name. (See The Name Gallery below.) 

Or you can use 'rotate+' to force the rotation to go clockwise or 'rotate-' to make it 

go counter clockwise. 

  

To take the simple two key frames animation example shown on the previous page, 

where the hour hand needs to move from 12 o‘clock to 8 o‘clock. If you name the 

hand object 'rotate+ hand' you'll get an animation showing the clock‘s hand moving 

clockwise. If you name it 'rotate- hand' then the hand will rotate counter clockwise. 

 

If there is no rotate command then the tween takes the shortest direct path 

between the object on one key-frame to the next, rotating around its center. With a 

‗rotate‘ command on the object name, then it calculates the actual rotation point, 

which in the above example is the ‗large end‘ of the hand. 

  

Note: it's not possible to rotate an object by a full 360° between key frames if the 

rotation point is not the center. For example, to do a full rotation of the clock hands 

in the above example, you would need to create an intermediate key frame. 

 

The Name gallery 

To display the Name gallery: 

 Choose Utilities > Name Gallery. 

 Or click the Name gallery button on the Galleries button bar. 

 
 

 
A typical Name gallery layout 

 



 

 

19 

 

Release 

Notes 

The Name gallery lists all fonts, bitmaps, named colors and object names used in any 

drawing or animation. You can see folder sections for each type of name. The 

important thing here is the object names for animation, the top folder, as you have 

to give names to all objects you want to animate from one key frame to the next. 

  

These are the key points to note when using the Name gallery: 

 To name a new object, select it and use the New button in the gallery or 

the Create New Names from the Selector tool InfoBar. Each object you 

want to animate must have a unique name, and must keep that name for the 

duration of the animation. i.e. on each key frame the object appears on, it 

must have its correct name. Luckily once you've given an object a name, it 

retains that name, even if copied and pasted. 

 You can apply a name from the Name gallery to any object by dragging it 

onto the object (or selecting the object and double clicking the name). In 

this sense, applying names is rather like applying colors to objects. This can 

come in handy if, for example, you copied an object to a number of key 

frames but forgot to name it. You can create the name, and then select 

each object to which you want to give this name, then double click the 

name in the Name gallery. 

 When you select an object, its name is shown highlighted in the name 

gallery with a half or full red circle: 

o  indicates and there are other objects or copies of this object 

with the name. 

o  indicates the selected object/s are the only occurrences of the 

name. This is useful if you want to be sure of selecting all 

occurrences of the named object. 

 You can select objects using the Name gallery. By clicking in the circle to 

the left of the name you will select some or all occurrences of the object 

with that name. As above,  means there are other occurrences of this 

named object that were not selected, typically because they appear on 

other frames and so are not visible and selectable.  means all occurrences 

of this name are selected. 

 If you want to select all occurrences on all frames, then you need to select 

the All Frames Visible or Edit All Frames buttons in the Frame gallery. 

 You can ignore the JPG or GIF symbols to the right. These are features 

used when exporting sliced web images. 

  

Important: do not use the Create New Names button on the Selector tool InfoBar 

to give an existing name to objects. This button, as the tooltip says, creates new 

names. If you've already created a name, then the only correct way to apply that 

name to an object is to use the Name gallery. (It really is like a gallery of names. 

Select the object and double click the name.) 
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Groups 

Groups are treated specially when creating animations. To save you naming each 

individual part of a group, you can instead name the whole group and then copy the 

group to the next key frame. Xtreme will animate the whole group from one key 

frame to the next. And you can apply the normal transformations to the group 

(resize, rotate, squash, but not group transparency—see the next page). 

  

If members of a group are to animate differently to the rest of the group, then those 

members must be separately named (Ctrl+click to select an object inside a group 

then name it as usual). 

  

Note: if you ungroup, make some changes to the group contents and then re-group 

the objects: 

 You must re-apply the name to the new group (select the group then 

double click on the name in the Name gallery). 

 You must not change the stacking order of the items in the group. 

 You must not add or remove items to the group. 

 

 

Group transparency 
If you want to fade a grouped object, you need to apply transparency to each 

individual object in the group. There are two ways you can do this: 

 Select each object in the group in turn and adjust its transparency. 

 Or un-check the Make Groups Transparent as a Whole option in the 

Options dialog (Utilities > Options then the General tab). 

If you do this, when you adjust the transparency of the whole group 

Xtreme applies the transparency to each individual item in the group, 

instead of group transparency. 

 

What Xtreme features does Flash support? 

The Flash vector rendering is quite primitive compared to Xtreme's, and so you can't 

use many of the more advanced Xtreme features such as feathering, complex 

transparency and fill types, bevels, soft shadows or contours. Lines (strokes) are 

limited to be being simple constant thickness, round ended lines. No line dashing is 

supported. The minimum line thickness is one pixel—so thinner lines in Xtreme will 

be displayed one pixel thick in Flash. 

  

There are two aspects to producing Flash-compatible drawings. The first is to limit 

yourself to use only those features supported directly by the Flash player. Secondly, 
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when producing animations, there is an even more limited set of characteristics that 

can be tweened or animated. 

  

Xtreme drawing features that Flash supports: 

 All normal line and shape drawings (although Flash is a lot less precise than 

Xtreme and so sometimes you may notice inaccuracies in lines and shapes). 

 Flat, linear, circular and elliptical gradient color fills. 

 Multi-stage gradient color fills, including linear and elliptical fills. Eight color 

stops maximum. 

 Flat transparency. Mix type only. 

 Graduated transparency is supported for flat color filled objects (non-

graduated). So you can have graduated color objects with flat transparency 

or flat color objects with grad transparency, but not both. 

 Constant width outlines (stroked paths) with rounded end caps and line 

joins (version 8 Flash files support the other join and cap types). 

 Text, including kerning. You can use any fonts you like. The outlines of the 

characters of any used fonts are embedded into the Flash file. This is much 

more efficient than, say, font embedding in PDF documents. 

 Text on a curve. Note: the line used for the curve must be made invisible 

for the animation to work. 

 Bitmaps and bitmap fills. 

 Contoned (colored) bitmaps and bitmap fills.  

 Fractal Cloud and Plasma fills will work, but are converted to bitmaps, so 

not efficient. 

  

So you can't use, amongst other things: 

 Any transparency type other than mix. 

 Feathering. 

 All complex graduated fills (conical, diamond, 3 color etc). 

 All complex graduated transparency styles (as above). (You can use linear, 

and elliptical transparency on flat color filled objects.) 

 Live Effects. 

 

The following object types will export in static Flash, but do not animate. 

 Soft shadows. 

 Bevels. 

 Contours. 

 Blends. 

 Molds. 

  

So while some Xtreme effects, such as soft shadows and bevels do work in static 

files, these are exported as bitmaps into the Flash file—so they are not very efficient 

and not suitable for animating.  

  

What can be animated: 

As listed at the start of this chapter, these are the golden rules as to what you can 
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change from one key frame to the next: 

1. Move—you can move objects from one position to another. 

2. Scale—you can enlarge or reduce objects in size. 

3. Squash or skew—you can squash or skew objects. 

4. Rotate—you can rotate objects. 

5. Transparency—you can adjust the overall (flat) transparency of the object. 

6. Color transform—you can change the fill (flat) color of objects. 

 Or any combination of the above. 

  

In addition there is one special case—you can animate text on a curve. This is special 

because you can use this to seemingly morph text along one curve into text along a 

completely different curve. In fact what it does is tween from the character position 

in one key frame to the corresponding character‘s position in the next frame. This 

can produce some interesting effects. Note: the line used for the curve must be 

made invisible for the animation to work. 

 
 

Non-moving objects 
You can add new objects by just drawing them on any key frame. They will appear in 

the animation at the start of the frame and will vanish at the next key frame, unless 

they appear on that frame as well. So the simplest way to have an object appear 

static on all frames is to ensure it's copied to all the frames. Xtreme Flash 

optimization is very efficient and you'll find that having more than one copy takes 

hardly any additional file space (this is true of multiple copies of objects anywhere). 

  

Color transforms—animating color changes 

This is what you can and cannot do with color transforms in Xtreme flash: 

 You can animate simple flat color changes of objects from one key frame to 

the next. 

 You can change the line color independently of the fill color. 

 You can change contone colors. 

 You cannot adjust the position of gradient fills. 

 You can use RGB, HSV or CMYK colors. These are all converted to RGB 

colors when exported to Flash (which is the only color model Flash 

supports). 
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Transparency 

As mentioned earlier, you can adjust the flat transparency of objects (not group 

transparency) and Flash supports this (for both static objects and tweening 

transparency changes), but Xtreme‘s graduated transparency is not really supported 

with Flash. There is just one situation where you can use graduated transparency, 

and that is on flat color filled objects. 

 

 
It's possible to adjust, and animate, flat transparency given 

 to all types of objects, shapes, text and photos. 

  

It's possible to give graduated transparency (linear, circular and elliptical) to 

flat color filled objects, but it's not possible to animate the transparency change. Although 

you can animate the color change (rule six). 

  

URLs in Flash 

To make an object in your Flash animation a clickable link, just select the object you 

want to make clickable and select Utilities > Web Address (shortcut Ctrl++W).  

 

Enter the required URL (and the selected the target frame if required). 

 

If you want to make text clickable select the Rectangle Surrounding Object option. 

This ensures those that viewers of your Flash animation can click anywhere over the 

text (rather than just on the actual letter shapes). 
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clickTAG 
clickTAGs are often used by advertising networks. Rather than hard-coding a URL 

into a Flash animation, the clickTAG allows an organization to insert their own URL 

into the animation—which is particulary useful for tracking advertising clicks. 

 

If you need to use this feature, just type clickTAG instead of a URL. 

 

 
 

Tip: if you wish to make your whole banner clickable, simply ensure that you have a 

background rectangle that has the URL on and that this appear on all frames. You 

would typically have such a thing anyway if you were using ClipView—just set the 

ClipView rectangle to have the URL. Or you could use the B Frame option. 

 

Background frames 
You can use the B option on the frame gallery to create a background frame. Create 

a rectangle in your required background color and place it on the first frame. Give 

the rectangle the required link then, in the Frame gallery, select the B check box by 

the first frame. This will make the first frame a background layer, and the content will 

appear throughout the animation making the banner always clickable. So typically this 

means your first frame would have no other objects on it (unless you want them to 

appear throughout the animation as well. And also you‘d probably set the Display 

Period to be 0 seconds to ensure this is displayed but there is no delay before 

moving onto the main animation. 

 

 

Advanced Flash Commands 

Accelerating and Decelerating 
Usually the tween steps are evenly spaced between key frames, producing a linear 

animation from one key frame to the next. By appending < and > symbols to the 

front of the object name, you can make objects speed up or slow down. So naming 

an object  >Name  means that it starts fast and slows. The opposite, <Name, would 

start slow and speed up. 
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You can even use these in combinations. So an object name <>Name would start 

slow, speed up and then slow down towards the end of the frame period. 

 

You can control the degree of acceleration or deceleration by using numbers from 0 

to 9. So <2Name  would be a very gentle acceleration, while <9Name would be 

extreme acceleration.  Similar >2 in front of the name would give a slight 

deceleration. Using the name >Name (with no number) is the same as >5 Name. 

 

Example: there is an example file called Pendulum in the Flash Examples section of 

the Clipart gallery (click the Get Clipart button on the Clipart Gallery). The 

pendulum group uses a combination of <> and the rotate command. Another 

example called Zoom6.xar is also worth examining. 

 

Stop and Goto commands 
You can append Stop or Goto commands onto the Frame names (separated by a 

semi-colon ; ) to control the sequence flow. So for example if your first frame was 

named ‗Frame 1;Goto Frame 6‘ then the animation sequence would jump to Frame 6 

at the start of Frame 1.  This may produce tween errors, but these can be ignored. It 

also waits for the specified period of the frame with the Goto command on before 

jumping—but frames with Goto or Stop commands to do not tween. 

 

Similarly a frame name with ;Stop appended to the end of the name would stop when 

the animation reaches this frame.  Why is this useful?  Because you can use a special 

form of URL link on objects that when clicked will re-direct the animation sequence 

to alternative frames. 

 

Clickable objects (buttons) 
If you apply a URL to an object (see earlier) where the URL is simply the frame 

name, and set the Target Frame field to be ‗_frame‘  (underscore frame), then when 

this object is clicked, the frame sequence will jump to the specified frame. In other 

words you can control the animation flow by clicking on objects. See the ‗River 

Thames‘ example file in the Clipart gallery. This uses a Goto command to loop from 

frame 4 to 3, and a URL frame re-direct to jump to Frame 1 if you click the Replay 

link in the corner. 

 

Xtreme Flash Animation Summary 

 Xtreme key frames are 'snap shots' of your animation at any point in time. 

Xtreme automatically produces a blend or tween of objects from one key 

frame to the next, to produce a smooth Flash animation.  

 There is no time line. Instead, the Frame gallery shows your snap shot key 

frames though time (top down). Just click the frame name to see and edit 

that key frame. 

The shortcut 

Ctrl++W is a 

quick way to open 

the URL dialog. 
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 If you set the Xtreme frame display time to be 2s then it will take 2 seconds 

to animate objects from their position at the start of one key frame to their 

positions at the start of the next key frame. Use the Animation Properties 

dialog to set frame display period.  

 To tell Xtreme which objects are to be blended or tweened between one 

key frame and the next, you name the object you want to tween. For each 

new object you want to animate click the Create New Names button on the 

Selector tool InfoBar and give it a name. The object must have exactly the 

same name on subsequent frames.  

 When you create a new key frame (snap shot) you usually do this by 

copying the current frame, and this copies all objects to the new frame 

along with their names. It's easy to then just move the objects as required.  

 All other (non-named) items appear static for the duration (display period) 

of the Xtreme key frame.  

 You can move, enlarge, reduce, rotate, stretch, alter the color or 

transparency between Xtreme frames. Transforming objects in this way is 

very efficient.  

 There is an overall frame rate for the whole Flash movie. The more Flash 

frames-per-second the larger the Flash file and the smoother the animation. 

 Because each Xtreme frame is a snap shot of the full animation, all objects 

that should appear at that snap shot should appear in the frame. You can't 

blend an object from Xtreme frame 1 to frame 3 without it appearing on 

frame 2.  

 You can only tween shapes as allowed by the six transform rules described 

earlier (move, resize, squash/skew, rotate, flat transparency and color 

change). If you change the shape in any other way it won't work. 

 

For further questions and answers relating to Flash animations please read Xtreme‘s 

help by selecting Help > Xara Xtreme Help in Xtreme (shortcut F1).  
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Chapter 2 
 

Text Tool 
  

 

This section covers: 

Rulers 

Margins and indents 

Tabs 

Text areas (text flow) 

Copying text styles 

Smart quotes 

Hyphenation 

Paragraph spacing 

Optimized text spacing 

Useful text shortcuts 
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Introduction 

Xtreme 3.2 offers a number of enhanced Text tool features including margin and tab 

control, first line indent or outdent control and linked flowing text stories. 

 

Xtreme 3.2 introduces a new type of text object—the text area—which can contain 

a ‗flowing‘ text story. So there are three basic types of text object that can be 

created in the Text tool: 

 

 Simple text lines: click on the page, and type. 

 Text columns: click and drag to create a column, and type. 

 Text areas: click and drag diagonally to create a rectangular area, and type. 

 

Definition: a text story refers to a single piece of flowing text which may cover 

several columns, flowing from one text area to another. It‘s called flowing text 

because, like water, as you add or remove text in one area it overflows into 

connected text  areas or flows back from text  areas. 

 

This chapter only covers the enhanced features in Xtreme 3.2. If you own the main 

Xtreme manual, we suggest you read Chapter 12: Text Handling in order to 

understand the basics of text handling in Xtreme before you read this chapter. 

 

Rulers 
To adjust tabs, margins and indents you need to turn on rulers in your document. 

 

To do this: 

 Chose Windows > Bars > Rulers. 

 Or press Ctrl++R (this is a new shortcut). 

 Or press Ctrl+L (when not in the Text tool). 

 

The enhanced text features will only appear on the ruler when you are using the 

Text tool and when the text cursor is in a text story or the text object is selected 

when in the Text tool. 
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Margins and indents 

Any changes you make are made to the current paragraph of text. (i.e. the paragraph 

containing the text cursor) or, if you have a selected region of text,  to the 

paragraphs of the selected region. 

 

You can apply changes to all text in a text story by selecting all the text within that 

story (Ctrl+A). To change more than one text story, select the text objects while in 

the Selector tool then change to the Text tool and make the required changes. 

 

 Left margin. Drag this to change the left margin of the text.  

First line margin. Drag this to change the left margin for the first line of 

the paragraph (useful for lists, as shown below). 

 Right margin. Drag this to change the right margin of the text. 

 

As you drag, a guideline will appear to help you position the margin. 

 

 
Demonstrating the left margin and first line margin 

 

 
Dragging a right margin 
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Tabs 

By default, text stories are created with tabs set 0.5cm apart. This means you can 

just press the Tab key and your text will be moved along to the next tab stop. You 

only need to define new tab stop positions if you want alternative tab spacing. 

 

These default tabs are shown as faint Ls on the ruler: 

 

 
Standard tabs, indicated by faint Ls 

 

Custom tabs 
To create a custom tab position, just click on the ruler where you wish to place the 

new tab. It will replace default tabs up to that point on the ruler. 

 

For example: 

 

 
The triangle indicates a custom tab 

 

To set more than one tab click multiple times on the ruler. 

 

To move a custom tab drag it along the ruler.  A guideline will appear to help you 

position the tab. 

 

To remove a tab drag it off of the ruler (default tabs will come back). 

 

Custom tab types 
You can set different types of custom tab. By default, custom tabs are left align tabs. 

This means that text will be aligned with the tab on the left of the text. 

 

To change the tab type, click the tab icon on the ruler. 
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The following custom tab types are available. You are not limited to just one type in 

a story, and can choose a different type then set additional tabs. 

 

Left align 

 

The text will be aligned with the tab to the left. 

 
 

Right align 

 

The text will be aligned with the tab to the right. 

 
 

Center align 

 

The text will be centered on the tab. 

 
 

Decimal point align 

 

The decimal points in the text will be aligned with the tab. This is useful for lists and, 

however long the number, the decimal points (periods) will be tab-aligned. 

 
 

How to creating hanging indents 
Hanging Indents, as they are known, are where the first line of a paragraph has a 

negative margin or a margin that hangs to the left of the normal left margin. 

Numbered or bulleted lists are examples of hanging indents. 

 

To create hanging indents: 

1. Drag the left margin inwards. 

2. Click on the ruler away from the left margin (creates a new tab stop) and 

drag this tab stop to be exactly over the left margin. 

3. Now each line will start outdented—you can insert any special character or 

number and press Tab to move to the left margin. And (as with this 

paragraph) all subsequent lines of text are indented to the left margin. 
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Text areas 

In the Text tool if you click and drag diagonally on the page you will create a 

rectangular text area. The blinking cursor will be positioned in the top left corner 

and you can type or paste text. 

 

If the text overflows the bottom of the text area the overflowing text is shown gray, 

although you can continue to edit this text as usual. 

 

Connecting text areas—text flow 
When text overflows the bottom of the text area, an overflow indicator is shown on 

the bottom of the area. If you drag this over any other text area, the overflow text 

will flow into the new text area, and the two areas become connected. This is shown 

with a flow arrow. 

 

 
Dragging the overflow indicator from one text area to another will connect the two areas so 

text flows from one to another. You can link as many together as you require. 

 

Tip: there is a quick way to create flowing text. If the text cursor in an area with 

overflowing text, then just click-drag on the page to create a new text area. The new 

text area is automatically connected and text will flow into the new area. 

 

To disconnect one text area from another, just drag on the overflow indicator and 

drop it away from any text area. 

If you delete a text area that is connected to another only the area is deleted—the 

text will simply re-flow into the remaining text areas. 

 

Resizing text areas 
In the Text tool you can click and drag on any of the corner control handles. The 

text in the area will be reformatted to fit the new size. 

 

Alternatively you can use the Selector tool to resize the text object, but in this case 

the behavior changes. Usually when you resize an object in the Selector it resizes 

everything including the text. So, for example, if you resize a simple text object or 

text column. This is consistent with the normal operation of the Selector tool. 
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However in the case of flowing text areas this would cause undesired side-effects—

you almost certainly do not want part of a flowing text story to be a different point 

size than the rest. Therefore the Selector tool behavior varies depending on whether 

you are resizing one text area that contains a flowing text story, or resizing the 

whole text story. The rule is: 

 If you resize a single unconnected text area (or simple or text column) then 

the area ‗container‘ and text content are resized together. 

 If you select the text areas of the whole flowing text story (they have to be 

one a single page) then a resize will resize the text and areas together. 

 But if you resize a text area that is part of a flowing series of text areas, 

then only the container size is altered and the text inside remains the 

original size, and will be re-formatted to fit the new size. This is like resizing 

a text area with the Text tool. 

 

If you want to resize all text in a text story, select it all with Ctrl+A, and apply the 

required font size. 

 

You can rotate a text area, using the Selector tool as normal, and the text will flow 

through the rotated text area normally. 

 
Text flow is unaffected if you rotate any of the text areas 

Word count 
The status line reports how many characters and words are within the selection, or, 

if there's no selection, how many are within the whole of the current text story. This 

updates as you type. This also shows the number of overflowing words. 

 

Copying text styles 

It‘s easy to copy the style of any text to any other region of text using the Paste 

Attributes feature: 

 Select the source region from where you want to copy the style. This can 

be as little as a word (just double click). 

 Select Edit > Copy (or Ctrl+C). 

 Select the region of text to which you want to apply the style. 
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 Select Edit > Paste Attributes (Ctrl++A). 

 

If you just have the text cursor positioned in some text when you Paste Attributes 

the paragraph attributes will be pasted to this paragraph (i.e. tabs, margins). 

 

If you have a region of text selected, then Paste Attributes will paste all the visual 

attributes of the source text.   

 

Applying attributes to whole text stories 
When you have the cursor in a simple or column text object, pressing Esc will select 

the whole text object. You can then apply an attribute, say a color, and the whole 

text object is altered. This is often quicker than performing a Select All (Ctrl+A). 

 

With text areas this method only works if all text areas of the story are selected. 

You can do this in the Selector tool clicking and +clicking on the different text 

areas to select them. 

 

Smart Quotes 

When you type a quote ' or double quote " characters Xtreme will automatically 

convert these into the more appropriate and aesthetically accurate opening or 

closing quotes. So this changes 'this' into ‗this‘ and "quotes" into ―quotes‖. It's 

smart enough to understand the use of single quotes within words to signify missing 

characters, so that 'don't' becomes ‗don‘t‘. 
 

Soft and Hard Hyphens 

If you type Ctrl+- (minus key) it inserts a soft hyphen which is a hyphen that only 

appears if the word can wrap at the end of a line. This is particularly useful for 

narrow columns of text where, to avoid rivers of white, you might need to 

hyphenate some words. Inserting a normal dash character will split the word at the 

end of the line.  Here's an example where there is too much space between words 

on the top line because the word 'hyphenate' doesn't quite fit. 
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If you type Ctrl + - after the word 'hyphen' then it breaks the word at that point and 

produces a more satisfactory word spacing. 

  

It's called a 'soft' hyphen because when the word appears in the middle of a line the 

hyphen vanishes (unlike a normal dash or minus character), so it intelligently 

hyphenates the words only if it needs to. 

  

When editing the text a soft hyphen is treated as an invisible character (it takes no 

space), but you can tell it's in the text by moving the cursor left/right over where the 

invisible character is. 

  

A hard hyphen can be inserted by typing Ctrl+Shift+ - (minus key). A hard hyphen is 

one that will not cause a wrap at all. This is useful in situations where you have 

dashes in words that you do not want split at the end of lines. 

 

Paragraph Spacing 

Two new fields on the end of the Text tool Infobar allow you to set the spacing 

above and / or below paragraphs. This is particularly useful where you want half line 

spaces between paragraphs. 

 

 
 Set the space above & below a paragraph 

 

Like Microsoft Word if you use both spacing above and below paragraphs, the 

spacing between paragraphs is whichever is the greater value (it's not cumulative).  

Paragraph spacing above paragraphs will move the 1st paragraph down in a frame of 

text. 

 

Optimized Text Placement 

If you just click and type (i.e. create a simple text object), the position of the type is 

adjusted very slightly, by fractions of a pixel, to ensure that the baseline of the text 

exactly sits on a pixel boundary. This results in sharper, more readable text at small 

point sizes and 100% zoom view (depends on the font and point size). But for 

example the default 10pt Arial or Arial italic is now noticeably less blurred for simple 

text objects. 
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Useful Text Shortcuts 

Paragraph Select 
A quad click - that is four rapid clicks in a row - is now a shortcut to select a 

paragraph. This is an extension of the existing standards: 

    Single click - positions cursor 

    Double click - selects word under cursor 

    Triple-click - selects line 

    Quad-click - selects paragraph. 

Swap Case 
Pressing Ctrl+W will swap the case of the character after the cursor, and move the 

cursor on.  So if you find you've accidentally typed a section of text with the Caps 

lock key on, just place the cursor at the start and press and hold Ctrl+W. This has 

now been enhanced so that you can swap the case of a selected region of text in the 

same way. 

Increase / Decrease Text Size 
New shortcuts of Ctrl+Shift+> and Ctrl+Shift+< will increase or decrease the point 

size of the selected text or selected text story (only if the selection is all the same 

point size). 

Manual Kern Key Changes 
The old kern shortcuts of Ctrl + and - have changed. (Ctrl+ - is now the soft 

hyphen). 

The new kern shortcuts are Alt+ left and right arrow keys. 

So to move two characters closer together press Alt+ < and to move them further 

apart press Alt + >. Each key press moves the character 50/1000 ems. 

These shortcuts are compatible with Adobe Illustrator. 

Special Characters 
A number of useful shortcuts have been added to allow insertion of special 

characters: 

Hard space:      Ctrl+Space  (words with hard spaces between will not wrap at the 

end of a line) 

EN dash:  –       Ctrl+NumPad – (An EN dash is longer than a minus, and is a more 

correct ‗dash‘) 

EM dash:  —    Ctrl+Alt+NumPad -  (An EM dash is a long dash) 

Ellipsis:     …    Ctrl+Alt+.  (That‘s with a Full stop or period character.  An Ellipsis is 

three dots …) 

Copyright:  ©    Ctrl+Alt+C 

Registered ®    Ctrl+Alt+R 

Trademark  ™   Ctrl+Alt+T 

Bullet •             Ctrl+Alt+B 
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All the above shortcuts (with the exception of the hard space) are compatible with 

Microsoft Word.  

 

Lorum Ipsum 
When creating page layouts, it's common practice to use dummy text, which is a 

type of pseudo-Latin (it doesn't really mean anything), but has the overall appearance 

of typical English text (or other similar Latin-based languages).  The text starts 

'Lorem ipsum dolor sit amet...'.  (In fact this same text has been used as dummy text 

going back more than 500 years in the print trade, and parts of the actual Latin used 

can be traced to text written more than 2000 years ago). 

 

You can now insert a paragraph of the Lorum Ipsum text by typing Ctrl+Shift+L (L 

for Lorum) when in the text tool. To insert a larger block of text just press the key 

combination a few times. 

 

 

 

RTF - Rich Text Format 

You can now import and export text in RTF format so it includes style information 

such as font, font size, color, margins, special and foreign characters (Unicode 

supported).  You can find more information on this in the chapter on File Exchange. 
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Chapter 3 
 

PDF export 
  

 

 

 

 

 

This section covers: 

Exporting PDF files 

Advanced export options 
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Introduction 

The Portable Document Format (PDF) provides the best way to transfer drawings 

and document to others.  The free Adobe PDF Reader is very popular and enables 

anyone to view and print your PDF document. 

 

PDF files are vector graphics files—which means they are resolution independent, 

and are great for printing on high resolution devices, and you can zoom in to view 

detail with no loss of quality.  Your graphics or document exported as a PDF should 

look exactly like it does in Xara Xtreme. 

 

Xtreme provides very comprehensive controls over many aspects of your PDF 

output. These are just some of the options and features you can control in Xtreme 

PDF output. You can: 

 

 embed fonts in the file which means all readers can be sure of seeing the file 

exactly as you intend, but this makes the files larger. You can also select to 

embed only a subset of the fonts (only the used characters) to reduce the 

PDF file size; 

 set it to re-sample all images or photos to be any required resolution so 

they are not unnecessarily high resolution; 

 set it to convert bitmaps to JPEG or remain in their raw state; 

 make it so that layers in your Xtreme drawing are visible and can be 

switched on and off in Adobe Reader; 

 select which version of PDF you want to create; 

 select which pages of a multi-page document; 

 make your PDF file password protected; 

 even embed the original .xar file (or other files) into the PDF for the 

ultimate in document portability. 

 

To make life easier all the options have been distilled down to three easy choices. 

When you export as a PDF you are presented with a choice of the following presets: 

 

 Draft quality. 

 Email distribution or Web download. 

 High quality. 

 

You can customize the settings of any of these presets by click the Advanced 

Options button. 

For very complex 

vector graphics, 

PDF can be very 

slow (sometimes 

20 times or more 

slower than 

Xtreme) so 

drawings that 

take a few 

seconds to draw 

in Xtreme can 

take minutes 

especially when 

printing. So 

sometimes it’s 

quicker to convert 

complex vector 

graphics into a 

bitmap before 

exporting your 

PDF. 
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Exporting PDF files 

To export a PDF file 
  

1. Choose File > Export (shortcut Ctrl++E). 

2. Select PDF (*.pdf) from the Save As Type list. 

3. Name the file then click Save. The PDF Export dialog will appear: 

 

 
 

The three preset options will be suitable for most PDFs. They are: 

 

 Draft quality (96 DPI, no font embedding) 

The draft setting is typically used when proofing a design and offers the 

fastest mode of PDF generation. The following settings are used: 

o PDF version 1.4. 

o No fonts are embedded. 

o All bitmaps and photos are embedded as JPEG images at 96dpi. 

 

This option will produce the smallest file, but note that is because no fonts 

are embedded. If you give the file to anyone they must have the any fonts 

used installed on their system in order to be able to see the document 

exactly as you intended. 
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 E-mail distribution or web download (Adobe Reader version 5 

and above)  

This setting specifies filter options that are optimal for distributing PDF 

documents through e-mail and the web. Fonts are included, so you can be 

sure your document will be viewed exactly as you intended and all images 

are medium resolution suitable for inkjet printing and viewing on screen: 

o PDF version 1.4. 

o Fonts are embedded, and subsetted (meaning only characters 

used are embedded as fonts). 

o All bitmaps and photos are converted to JPG at 150 dpi. 

 

 High quality (300 DPI, larger PDF files)  

The high quality setting includes options for rendering designs as PDF 

documents where full fidelity is required at high resolution. This if most 

suitable for printing on inkjet printers or viewing at high zoom. The 

following are the key settings: 

o PDF 1.4. 

o Fonts are embedded, and subsetted (meaning only those 

characters used are embedded as fonts). 

o All bitmaps and photos are passed through untouched, unless they 

are more than 300 dpi in which case they are sampled down to be 

300 dpi but retain their existing type (they are not all converted 

to JPG). 

 

Customizing PDF export using advanced options 
If you select the Advanced Options button you can customize any of the above 

presets. Once you have altered any of the preset values, the next time you export a 

PDF it remembers the last settings, and the Custom option will be shown. The 

following section provides an overview of this feature. 

 

While the three presets included in the PDF Export Filter will cover most typical 

scenarios for generating PDF output, situations may arise when greater control is 

required in order to specify the properties of the resulting document. 

  

To customize the output filter settings:  

1. Select the preset that is closest to the desired type of PDF. 

2. Click Advanced Options.... 

3. Modify the desired filter settings. 

4. Click Export to generate the PDF document. 

  

The modified settings will automatically be stored under the Custom option for use 

from that point on. 

  

When the Advanced Options button is clicked, the PDF Export Filter options appear 

in a separate dialog box grouped within the following categories: General, Objects, 

Document, Layers, Pre-Press (Xtreme Pro only) and Security.  
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PDF versions 
PDF has evolved over the years as more features have been added. Typically along 

with each new version of PDF, and new version of Adobe Reader is released to 

support the new PDF features. Unfortunately, to confuse everyone, the version 

number of PDF Reader and the PDF file do not match. So, for example, Adobe 

Reader version 5 is required to read PDF versions 1.4. 

 

PDF version 1.4 was the first version to support transparency and so is the minimum 

generally recommended version to use.  Later version support some of the extra 

features. For example if you want to use the Layer feature (so you can switch on an 

off Xtreme layers in the Adobe Reader) you need to export as PDF version 1.5 or 

higher, and this required Adobe Reader version 6 or higher. 

 

 You can export files in PDF version 1.3, 1.4, 1.5 and 1.6 formats. 

 

Some Xtreme features do not exist in PDF or are implemented differently: 

  

 Transparency. PDF version 1.3 does not support transparency. Any 

objects containing transparency will be exported as bitmaps, a process 

sometimes called ‗flattening‘. Xtreme does this automatically. The resulting 

PDF file should still look correct however. 

 Transparency types. The bleach, mix and stained glass types are mapped 

directly to the Screen, Normal and Multiply transparency types available in 

PDF version 1.4 and greater. All other objects that use these transparency 

types are exported as bitmaps. Conical, Diamond, Three Color, Four 

Color, Fractal Cloud fills and Fractal Plasma fills will transfer fine, but are 

exported as bitmap fills. 

 ClipViews. PDF export does not directly support ClipViews comprised of 

lines or text. Convert all lines and text to shapes to ensure that a ClipView 

that contains these objects is properly converted. 
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PDF Export Filter Settings: General Options 
 

 
 
The General Options tab in the PDF Export Filter provides a range of settings that 

can be configured to specify PDF document attributes including version compatibility, 

how content is encoded and which pages are to be rendered. 

  

PDF Version compatibility 

The PDF Export Filter supports versions 1.3, 1.4, 1.5  and 1.6 of the PDF format to 

ensure compatibility with a wide range of applications. Unless PDF version 1.3 

compatibility is required, select PDF version 1.4 or greater as the output format as 

this will provide support for transparency.  

  

Color Model 

The color encoding standard for the PDF document can be selected from RGB and 

Native. The Native option represents colors in the PDF file as they are specified in 

the drawing using RGB. 

  

Options 

 Optimize for fast web viewing (linearization). Linearization of PDF files 

generated by the export filter encodes the PDF for optimal transfer and 

viewing over the Internet. Be default this option is enabled. 

 Embed fonts when permitted. Select this option to include copies of fonts 
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in the PDF file that are not included in the PDF base 14 fonts supported by 

Adobe Reader. Note that only those fonts that are not restricted by 

copyrighting restrictions will be embedded in the PDF file. By default this 

option is enabled.  

 Font subset only. This option can be used in conjunction with the Embed 

Fonts When Permitted option to indicate that only those characters that 

are used within a typeface will be embedded in the resulting PDF file. 

Selecting this option can reduce the size of the PDF file that is generated 

however it will also limit the level of editability. By default this option is 

unselected. 

 View PDF when finished. This option can be selected to automatically 

launch and view the resulting PDF using the default application that is 

associated with the format under Windows. This option is enabled by 

default. 

 Enable Continuous Scrolling in Adobe Reader. Choose this option to have 

Adobe Reader synchronize the scrolling of the PDF document with the 

movement of the scroll bars in the viewing application. By default this 

option is selected. Note: this option only applies to PDF documents that 

contain more than one page. 

  

Page Generation 

When generating a PDF document from a design, Xtreme includes a feature that 

allows a range of pages to be specified. This is useful when a design has been created 

that contains multiple pages. 

 

To specify which pages are to be rendered to the resulting PDF document: 

 Select All to render all pages contained within the design 

 Current Page to print the currently selected page or 

 Selected objects to print only those objects that are selected. 

 To print a range of pages within the design, select Pages and enter the 

desired range in the edit box. Specify individual pages by their number, 

separated by commas. To specify a range, enter a starting and ending page. 

For example, to specify that the first, third page and pages 5 through 12 of a 

design should be rendered to the resulting PDF document enter the 

following: 1, 3, 5-12. Note: pages will be rendered to the PDF document in 

the order in which they appear in the original design. 
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PDF Export Filter Settings: Objects Options 
 

 
 
The Objects tab in the PDF Export Filter provides a series of settings that can be 

used to specify how design elements are rendered in a PDF document. 

  

Bitmap Compression 

Choose the compression scheme for bitmapped images that appear in the document 

by selecting from the options in the drop-down list. Supported compression schemes 

include: Native (use the bitmap compression in the document), None (do not apply 

compression) and JPEG and Flate.  

 

JPEG Quality 

Use the slider control to set the JPEG quality index when using JPEG compression 

for bitmapped images. Values range from 0 to 100, with higher values specifying 

increased quality and lower values specifying increased compression and the loss of 

some image fidelity. The default JPEG quality is 85. 

  

Rasterization Resolution (DPI) 

For Xtreme graphic objects that cannot be exported as native vector PDF objects 

(things like soft shadows, feathered objects, bevels) Xara will automatically rasterize, 

that is convert to a bitmap. This option allows you to choose the DPI (dots per inch) 

for the rasterization resolution using the drop-down list, or click Use Custom DPI 

and enter a custom value by checking the Use Custom DPI option and specifying an 
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integer value between 20 and 600. The default preset value for rasterization is 150. 

The higher the resolution the larger the PDF file. It is not usually necessary, even for 

the highest quality printing to use a value above 300dpi. 

  

Options 

 Include hyperlinks. Select this option to preserve any objects containing 

hyperlinks in the outgoing PDF file. By default this option is selected for 

standard PDF documents.  

 Convert text into shapes. This option can be selected to convert all text 

content into vector shapes. This option can be specified to preserve the 

appearance of text when equivalent fonts may not be available on the target 

system or when font embedding is not permitted. Note that the text in the 

resulting PDF file is translated into shapes and is no longer editable as text. 

By default this option is unselected. 

 Use Unicode for text encoding. This option can be used to select the 

method to be used for encoding text in the resulting PDF document. By 

default, this option is unselected and text is encoded using the ANSI 

encoding scheme. Selecting this option specifies that text should be 

encoded using Unicode. 

 Preserve bitmap tiling. This option determines the method that the 

export filter uses to generate tiles in the PDF file. By default, the preserve 

bitmap tiling option is selected and a series of individual bitmaps are used to 

fill the corresponding object. This option should be unchecked when the 

resulting PDF files are to be used in Adobe Illustrator 9 and 10 or in any 

other application that does not directly support bitmap tiles as fills. 

 Preserve Groups. Use this option to maintain groups in the resulting PDF 

document. Note that because the PDF format does not natively support 

groups, grouping is emulated using clipping masks.  
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PDF Export Filter Settings: Document Options 
 

 
 

The Document tab contains items that can be used to specify authoring information 

and how a PDF document will viewed within Adobe Reader. 

  

Description 

Within this section, the title, author, subject and keywords for the outgoing PDF 

document can be optionally added. Select Include Document Information to embed 

these details in the resulting PDF file. By default this feature is unselected. 

  

Initial View 

Select from among the document viewing options in the drop-down list to specify 

the magnification level of the resulting PDF file when it is viewed in applications that 

support this feature. The default magnification level is 100%. 
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Reader Display Setup 

When generating a PDF file that is intended for display in Adobe Reader, you can 

select from among the display setup options in the drop-down list to specify how the 

viewer is configured when the file is opened.  

 

Options are included for displaying only the page, the bookmarks panel and page, the 

pages panel and page, a full screen version of the document, the layers panel and page 

(PDF 1.5) and the attachments panel (PDF 1.6). The display setup options for 

showing the bookmarks, pages and the layers panel are particularly useful when 

generating PDF documents in which layers are used. 

 

The default Reader display setup option is Page only. 

  

File Embedding 

A unique feature supported by the PDF document format is its ability to embed files 

at the document level. The Xtreme PDF Export Filter allows one file of any size and 

 type to be added to the exported PDF. When the PDF document is opened by 

applications that support file embedding (such as Adobe Reader or Acrobat), the 

embedded file appears in the attachments list panel. 

 

Embedding a file within the PDF document is particularly useful when distributing an 

illustration or submitting it to a service bureau. Examples for the use of this feature 

include attaching the original Xtreme .xar file, a readme file outlining author and 

copyright information or a high resolution rasterized version of the illustration to the 

resulting PDF. 

 

To embed a file within an outgoing PDF document, simply click the ellipses button 

[...] to select a file from within a file open dialog or type in the path of the file 

manually.   

 

Enable Embed Selected File to add the file to the PDF document. By default this 

option is unselected. 

 

An optional description may also be provided for the embedded file. This description 

will appear as a comment when the attachments panel is viewed in Adobe Reader 

and Acrobat. 

 

Note: file Embedding requires that the PDF Version compatibility be selected as 1.4 

or greater.   
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PDF Export Filter Settings: Layer Options 
 

 
 
The Layers tab within the PDF Export Filter provides a means to specify how layers 

within a drawing are rendered for in the PDF document. 

  

General Options 

Exclude invisible layers. This option can be checked to exclude all invisible layers 

in the outgoing PDF file. To eliminate guide layers from a PDF document, set the 

layer to invisible in the Xtreme layer gallery and export the drawing with this option 

checked.  

  

Layering Methods (standard PDF only) 

1. Do not generate Reader layers.  Separate layers do not appear in the 

resulting PDF document. This option is enabled by default.  

2. Enable Reader layers in a single page (PDF 1.5 and above only). Layers are 

rendered within the document on a single page, with layering labels 

included for display within Adobe Reader's layer gallery.  

3. Generate separate pages for each layer. Each layer is rendered to a 

separate page within the document.  
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4. Generate a separate PDF document for each layer. Each layer is rendered 

to a separate PDF file. If this option is selected, the PDF filename entered is 

combined with the layer names from the design to produce a unique name 

for each page. For example: if 2  layers appear in the drawing, named Layer1 

and Layer2, and Drawing.pdf is specified as the export filename, then 2 PDF 

files, Drawing.Layer1.pdf and Drawing.Layer2.pdf are created. An additional 

option allows for bookmarks (also referred to as "outlines") to be included 

within the resulting PDF document when separate pages are rendered for 

each layer. This allows for quick navigation to any page that corresponds to 

the layer in the original drawing using the layer name.  

5. Generate bookmarks for each layer. Select this option to include 

bookmarks in the resulting PDF document when layers are represented on 

separate pages (option #3 above). By default this option is unselected. 

 

Note: options 3 and 4 do not apply when generating PDF documents that consist of 

multiple pages.
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PDF Export Filter Settings: Pre-Press Options 
(Xtreme Pro Only) 
 

 
 

The Pre-Press tab includes items for specifying characterization settings and the 

embedding of ICC (International Color Consortium) color profiles for print 

production.  

 

ICC profiles are files containing data that specifies how colors are to be rendered on 

a particular output device. The use of an ICC profile is mandatory for PDF/X 

documents, optional for CMYK-based PDF documents and not applicable for all 

other types of PDF documents. 

 

Specifying an ICC profile of use in PDF/X documents: 

  

Output Intent Profiles 

When generating a PDF/X document for print production, output intent profile 

settings based on an ICC profile must be specified in order to ensure that the output 

is rendered properly on the intended output device. Xtreme includes presets for the 

most popular output intent profiles used in North America, Europe and Japan. To 

specify the use of one of the preset output intent profiles, simply select it from the 

list.  
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Custom Output Intent Profiles 

If the output intent profile that is required for print production is not provided in the 

list provided with Xtreme Pro, it is possible to enter the desired output by selecting 

'Custom' in the intent profiles list. Here you may enter the optional Output 

Condition and the required Output Condition Identifier that corresponds to the 

output device.  

 

Note that for PDF/X compliance Custom profiles must be embedded in the resulting 

documents. Follow the instructions below for details on how to specify the location 

of ICC profiles. 

 

ICC Profile Embedding 

The Xtreme PDF filter includes provisions for embedding ICC files within a PDF 

document.  An embedded ICC profile is required for a Custom output intent if the 

characterized printing condition is not in the registry of CMYK characterizations on 

the ICC web site (www.color.org).  

 

The output intent profiles included with Xtreme Pro are not embedded in the 

resulting PDF/X document as they are readily available in workflow environments.  

 

To embed an ICC profile within a PDF document: 

 

1. Click the ellipses button [...] to select a file from within a file open dialog or 

type in the path of the file manually. 

2. Click Embed This Profile to include the ICC profile in the outgoing PDF 

document.  

 

By default the file embedding feature is unselected. 

 

Note: please be sure to consult with your print service bureau to determine the 

appropriate settings for all pre-press options. 

  

Specifying an ICC profile of use in CMYK-based PDF documents: 

 When a CMYK color model is selected for standard PDF documents a 

profile may be specified from the Output Intent Profiles list as a reference 

when performing the actual color conversion. The output intent profiles 

included with Xtreme Pro may be embedded in the resulting PDF 

document by clicking Embed this profile. If you wish to use a profile that is 

not included in the list of presets, specify a Custom profile as described 

above and select whether or not you wish to embed it in the document. 
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PDF Export Filter Settings: Security Options 
 

 
 

The Security tab provides support for specifying security attributes and permissions 

settings that determine how the PDF document can be used once it is distributed. 

These options are only available for standard PDF documents and cannot be used 

when generating PDF/X files. 

  

To include these security settings in the outgoing PDF document, check "Apply 

security". By default this feature is unselected. 

  

File Open Password 

To password-protect a PDF document, specify and confirm a password. This 

password will be required when a user attempts to open the document for viewing.  

 

Note that it is strongly recommended that a document also be encrypted if a file 

open password is applied as this security scheme is known to be relatively easy to 

compromise. As a result, file open passwords should only be used as a means of 

security to prevent inexperienced users from accessing sensitive documents. 
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Document Encryption and Permissions Password 

To encrypt a PDF document, select an encryption method and specify and confirm a 

password. This password will be required when a user attempts to make changes to 

the document, including modifying security and permissions settings. The encryption 

password is often referred to as the owner or master password and it may also be 

used to open the PDF document. 

 

Additional document permissions settings (outlined in the section below) may be 

applied to determine the degree to which a user can interact with the encrypted 

document. 

 

Four encryption methods are available: 

 None. This setting will not apply any document encryption. This is the 

default encryption option for the document.  

 40-bit RC4. This setting will apply a 40-bit encryption algorithm to the 

document. 

 128-bit RC4. This setting will apply a 128-bit encryption algorithm to the 

document.  

 128-bit AES. This setting will apply the 128-bit AES encryption algorithm to 

the document. If the PDF document contains confidential or highly sensitive 

material this method of encryption is considered to be the most effective 

means of securing the contents.  Note: PDF 1.6 is required to support this 

encryption method. 

  

Document Permissions Settings 

The document permissions settings section allows you to specify actions that can be 

undertaken on an encrypted PDF document when it is rendered or processed by 

another application. 

 

Within the Document Permissions Summary section, check any of the following 

settings to allow a user to perform the following tasks: 

  

Printing 

Selecting this option allows a user to print the PDF document. By default this option 

is selected. 

  

Extraction for accessibility 

Selecting this option allows content to be extracted by applications that assist users 

with impairments. By default this option is selected. 

  

Commenting  

Checking this option allows users to add comments and annotations to the PDF 

document. By default this option is selected. 
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Modification 

Enabling this option allows users to change the contents of the PDF document. By 

default this option is selected. 

  

Document assembly (requires 128-bit encryption) 

Checking this option allows a user to merge or append this document with other 

documents. By default this option is selected. 

  

Content copying or extraction (requires 128-bit encryption) 

Selecting this option allows a user to copy or extract elements of the document, 

including text and graphics. By default this option is selected. 

  

Note: the PDF document must be encrypted in order for these permissions settings 

to be applied. In addition, the responsibility for respecting these permissions settings 

is left to the application that is used for processing the PDF document.  
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Chapter 4 
 

File Exchange 
 

 

 

 

 

 
 

 

 

 

 

 

 

This section covers: 

Photoshop PSD import and export 

TIFF import and export 

PDF import 

RTF import and export 

EMF & WMF import 

SVG export 
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Introduction 

Xara Xtreme supports a very wide range of both vector and bitmap file formats. 

Xtreme 3.2 extends this by offering much improved Adobe Photoshop PSD import 

and export, better TIFF import, improved PDF export and also PDF import.  Each of 

these is described briefly in this chapter. 

 

Because PDF is now becoming a universal portable document format, this is now the 

recommended way of transferring vector graphic files to and from applications such 

as recent versions of Adobe Illustrator, and other applications that support PDF. 

 

Xtreme 3.2 supports both the import and export of Adobe Photoshop PSD files 

preserving layers. 

 

Drag and drop import 
Xtreme supports drag and drop import of most file types. If you drag a file from your 

File Explorer onto an open Xtreme document it will import the file and place it on 

the current page, centered on the drop point. 

 

If you drop the file into any bar or the title bar it will open the file as a new 

document. 

 

Alternatively if you select File > Import you get the choice of importing the 

document into the current page or adding it as a new page. 

 

Importing a Photoshop PSD file 

To import a PSD file, import the file as normal with File > Import, or just drag and 

drop the .psd file into Xtreme. 

 

The layers in the PSD file, and the layer visibility setting will be preserved and will 

become Xtreme layers. You can view them by opening the Layer gallery.  

 

The Photoshop blend modes Normal, Multiply and Screen are compatible with the 

equivalent Xtreme transparency types Mix, Stain and Bleach and will remains editable 

in Xtreme using the Transparency tool. 

 

Tip: if you have separate objects in Photoshop that you wish to be able to move and 

change independently of one another in Xtreme, place them on separate layers in 

Photoshop before exporting. 

 

 

Photoshop calls it 

Opacity, but it’s 

the same thing as 

Transparency just 

the other way 

around. So a 90% 

opacity value in 

Photoshop 

becomes a 10% 

transparency 

setting in Xtreme. 
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Exporting a Photoshop PSD file 

Photoshop is a bitmap editor so when exporting to PSD format all the vector objects 

in Xtreme are rasterized. You can select the resolution (dpi) when exporting. 

 

Always save your work in Xtreme prior to exporting. Then, if you wish to alter your 

original objects in the future, just load Xtreme, make any changes and then export 

the required objects again. 

 

To export as a PSD file choose File > Export then select Adobe Photoshop in the 

Save as Type list. 

 

Layers 
Layers in Xtreme are retained when exporting to PSD format. Each layer is 

rasterized as a separate PSD layer, including layer names. Layers visibility is also 

passed through, so layers set to invisible in Xtreme will be exported and set to 

invisible in Photoshop. You can turn the layers on and off in Photoshop using the 

Layers palette. 

 

Transparency and layers 
The three most common Xtreme transparency types (Mix, Stain and Bleach) are 

compatible with Photoshop transparency (blending mode) types (Normal, Multiply 

and Screen). But because Xtreme is vector object based, it‘s possible for each 

individual object to have its own transparency type and value. In Photoshop this is 

not possible, and you can only set the opacity or blending mode for a whole layer. 

This means that for maximum compatibility and editability in Photoshop, you should 

place objects that use Stain and Bleach transparency on a layer of their own in 

Xtreme.  This way, when you export, these objects remain as separate editable 

layers, and with the correct transparency type (or blending mode as Adobe calls it). 

 

If you combine objects that use different types of transparency on the same layer in 

Xtreme, you will get an alert warning you of this when you export. This may looks 

OK when you export still.  Transparency types other than Mix, Stain and Bleach are 

not compatible with Photoshop. 

 

 

Text 
You can export text from Xtreme to be editable text in Photoshop, but the text 

must be on a layer on its own. (On import you may be asked to update the text 

objects for them to be editable in Photoshop.) 
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Text that is on a layer with any other graphic objects will be rasterized into that 

layer, and thus not be editable.  

Export DPI 
You will be able to set the DPI of the bitmaps in the exported PSD file.  

 

 
A DPI of 96 is the normal Windows screen resolution, and so exporting at 96dpi will 

appear in Photoshop at the same size at 100% as it does at 100% in Xtreme. 

 

For print work you should choose a higher DPI. 

 

You can select to export the whole Xtreme page area or just the areas of the visible 

objects only. 

 

Summary 
In order to get maximum compatibility and editability in Photoshop: 

 For the parts of your drawing that you want to remain separate layers in 

Photoshop—place on separate layers in Xtreme. 

 If you use Stain or Bleach transparency, make sure those objects are on a 

layer of their own. 

 Do not use any transparency type other than Mix, Stain or Bleach. 

 If you want your text to be editable in Photoshop, place it on a layer of its 

own, with no other graphic objects. 

 

TIFF Import 

Xtreme 3.2 TIFF import now supports a much wider range of TIFF file types, 

including: 

 Fax TIFF files (black and white images. Multi-page faxes will be imported as 

multiple pages into Xtreme). 

 TIFF with transparency. (If exporting a TIFF from Photoshop (Save As) you 

can select the Save Transparency checkbox.) 

 Mac or PC byte order TIFF files. 

 TIFF with layers and transparency. (If saved from Photoshop the rules for 

blend mode compatibility are the same as for PSD files). 

 JPEG in TIFF (transparency is not possible in this case). 

Usually TIFF files 

have a file 

extension of .tif. 
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PDF Import 

PDF is a complex vector graphics format that has evolved of 10 years or more and 

contains numerous sub-formats and options. PDF was designed as a portable 

document format for viewing and printing only, and not intended as a file format for 

transferring data between applications. However Xtreme should load the vast 

majority of PDF files. 

 

PDF is now the recommended way of transferring vector files from Adobe Illustrator 

to Xtreme. Save as PDF and then import the resulting file into Xtreme. 

 

The following points are worth noting: 

 Multi-page PDF files are imported as multi-page documents in Xtreme. 

 Text in PDF files is typically broken into many separate small text objects in 

the PDF file. This doesn‘t stop it viewing and printing, but means when 

imported what might appear as one or more continuous paragraphs of text 

is not. Xtreme tries to re-assemble the lines of text into lines and 

paragraphs of editable text, but often you will find the text broken into 

separate text objects. 

 In order to make it easier to extract just the text of a PDF file, a new layer 

is created containing just the text on that PDF page. Use the Layer Gallery 

to view this layer. 

 PDF files make liberal use of clipping. This appears in Xtreme as ClipView 

objects, and so it‘s often necessary to use Arrange > Remove ClipView in 

order to edit the objects on the page. 

 

 

What might not work: 

 Many PDF files include embedded fonts. It‘s not possible to legally extract 

and install these fonts onto your system. So if you do not already have the 

fonts used in the PDF file you will find alternative fonts have been 

substituted. 

 Files that are encrypted or password protected cannot be imported. 

 Any text in PDF files that use embedded subset fonts will not be readable 

or editable. 

 

RTF Import and Export 

You can now copy and paste 'rich text' (as it's sometimes known) to and from other 

applications such as word processors or editors and Xtreme, including style 

information such as font, font size, color, margins, line spacing  and special and 
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foreign characters (Unicode supported). This makes it dramatically easier to retain 

the style and appearance of your text.   

  

When you paste 'Rich Text Format' from other applications you are given the choice 

of pasting the text in as 'Unformatted Text' which means it will appear in the font 

and style at the cursor where you paste, or Rich Text Format which means it will 

retain the style of the source text. 

 

 
Cut & paste from Microsoft Word 

  

This also works the other way around. You can copy text in Xtreme and paste into 

other applications that support rich text editing and the style (font, size, colors, 

margins etc) will be retained.  This will only work if you select and copy a single text 

object or from a single text flow. 

 

Some applications, such as Microsoft Word, have a 'Paste Special' menu option that 

provides a wider range of paste options. These applications will sometimes allow you 

to choose the format of the pasted object (text or graphic). 

 

 

EMF - Extended Metafile Format 

There is now support for EMF import, a vector graphic format supported by many 

modern Windows applications. WMF (Windows Metafile) import has also been 

enhanced.  

 

You can import using the Import menu option or just drag and drop the file onto the 

Xtreme window. 

 

SVG Export 

A new SVG export option is available. This is not complete, but can be used to 

export basic vector graphics into SVG format. This plug-in will continue to be 

enhanced.  
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Chapter 5 
Other Enhancements 

 

 
 

 

This section covers: 

 

Bitmap & Photo Handling 

Improvements 

Zoom 

Document Scrolling 

Color Handling 

Fill Handling 

Vista Compatibility 

Key Shortcut Changes 

Right Drag Copy 

Easy Rotate 

New Templates 

Other Miscellaneous Changes 



 

 

63 

 

Release 

Notes 

Bitmap and Photo Handling Improvements 

External Photo Editors 
Xara Xtreme now integrates with external photo editors. Xtreme still contains the 

Xara Picture Editor (XPE) as the default photo editor, but is now also bundled with 

an alternative MAGIX photo editor. 

 

What's more there is now UI to allow you to select not just whether XPE or the 

MAGIX photo editor is used, but to call any external editor.  Xara Xtreme monitors 

the photo file being edited, and detects when it's updated by the photo editor and 

then re-imports it back into Xtreme. So this should allow integration with many third 

party photo editing solutions.  This is completely asynchronous. So you can continue 

to have your photo editor open and work on the drawing in Xtreme. Whenever the 

image file is updated from your photo editor (when you click save), Xtreme re-

imports it and updates your drawing. So you can just continue working on your 

photo in your photo editor, and every time you click save - Xtreme automatically 

updates to show you the new picture in context. 

 

You can now edit both photos and photos inside shapes (bitmap fills) just by double 

clicking on the photo or shape. 

 

One of the consequences of editing photos in external editors is that the bitmaps are 

expanded from JPG format into raw (PNG) bitmaps so that the editing process is 

lossless. This means that editing photo images with external editors will enlarge .xar 

files, possibly quite considerably. This does not apply when using the XPE editor.  

 

 
You can now choose the default photo editor 
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A new ‗Editing Bitmaps‘ option has been added to the Options dialog, Effects & Plug-

ins tab, where you can choose to use XPE or an external bitmap editor. 

 

Photo Drag and Drop 
We‘ve made significant improvements to drag ‗n drop handling of photos. You can 

now drag a photo from either the galleries (bitmap, fill or clipart) or a photo file 

dragged from your File Explorer over any existing photo (be it a stand-alone photo 

object or a photo 'fill' inside a shape) and it will be replaced. This works for photos 

inside shapes and even inside groups. The photo is now resized to best fit the 

container. The best way to illustrate the benefit of this new feature is to just drag 

and drop alternative photos onto some of the new template designs. It is now 

trivially easy to replace photos with alternatives.  The Fill tool is automatically 

selected after you drop a bitmap this way to make it easy to manipulate. 

  

One consequence is that if you want to drag and drop import a photo, and don‘t 

want it to replace an existing photo, then you should now drop it on the 

background away from any existing photo. 

  

Another change is that dropping photos onto normal shapes no longer works the 

same way. To fill normal shapes with the photo (or bitmap), you now have to hold 

the Shift key when you drop the bitmap. 

  

Photo Resize, Rotate and Push 
When you drop a photo onto a shape to replace the existing one it is sized to just fill 

the visible shape. You can resize and rotate the image by dragging the ends of the fill 

arrow (the correct aspect-ratio now remains locked when you do this).  You can 

push the picture around inside the shape by dragging on the center fill handle, 

anywhere on a fill arrow or by holding Shift and dragging anywhere on the photo 

  

If you hold Shift while dragging the ends of the fill arrow it will stretch / skew the 

bitmap. Holding Ctrl will constrain the angles. 

 

 
Resize and rotate the fill by dragging the ends of the fill arrows 

Push the fill by dragging anywhere on the fill arrow 
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Bitmap Fill Replacement 
If you drag and drop fills from the fill gallery - these continue to operate under the 

old rules. (You can drag and drop a fill onto any shape to fill it, and it becomes a tiled 

fill, and uses different sizing rules). 

 

Zoom 

We've enhanced the scroll wheel zoom (hold down Ctrl) so it's much smoother, less 

flickery and faster. For those that prefer to have the scroll wheel always zoom, 

there's a new option (Options dialog, Mouse tab) to make the scroll wheel 

always zoom in and out, rather than document scroll (useful if you're working on 

photos a lot or single page documents).   

 

 
You can set the mouse wheel to scroll the document or zoom 

 

In combination with scroll wheel press (to pan documents) this provides a really 

efficient, keyboard-less way to zoom and pan around your documents. 

 

Most digital camera photos will be too large to fit on the page, so Xtreme now 

automatically zooms out when you import a photo, so the whole image is instantly 

visible.  You can return to the previous zoom by clicking on the previous zoom 

button on the standard button bar. 
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previous zoom 

 

A new '100% zoom' operation has been added to zoom toolbar (visible when you are 

using the zoom tool). 

 

 
100% zoom on the zoom toolbar 

 

And there are also new key shortcuts for common zoom actions; plain numeric 

1,2,3,4 set the zoom to be 100% - 400%. Number 5 sets it to be 50% (the old 

shortcuts on these keys have been moved to Ctrl+Shift+1, 2 etc). 

 

 

Document Scrolling 

We've also enhanced the document scrolling using the mouse wheel to make it 

accelerated. So scrolling through larger documents is now a lot quicker and more 

efficient. 

 

Color Handling 

There have been significant changes to the way colors are handled.  The old template 

based selection of primary colors has gone and been replaced by a 'Standard Palette' 

of 46 pre-defined colors. There are 5 shades of 7 standard hues and 10 shades of 

gray, black and white. 

 

 
 

Standard Palette colors, like other library colors are not editable (i.e they are not 

Named Colors) and are designed as a simple, limited selection of colors to apply to 

objects (either by dragging onto the object or clicking). 

  

The old ‗web browser palette‘ has been switched off (no longer relevant or useful 

since 256 color screen modes are no longer used). It remains in the Color Gallery is 

you want to enable it again. 



 

 

67 

 

Release 

Notes 

Named Colors 
With older versions of Xara Xtreme, each time you used a palette color, it was 

added to the color line as a new Named Color. This typically resulted in dozens of 

Named Colors appearing on the color line during the course of creating the 

document, many of them no longer used. This no longer happens. When you create 

any color (e.g. click one of the Standard Palette colors) it just applies that as a local 

color to the object. You can of course edit this color using the Color Editor as usual 

(Ctrl+E). Only if you select the 'New Named Color' icon in the color editor is a new 

Named Color created.  

 

Automatic Removal of Unused Colors 
When you save and load files, all unused Named Colors are now removed from the 

color line. This results in a much, sometimes very much, simpler and cleaner color 

line. 

  

If you want Xara Xtreme to work the old way un-check the 'Delete unused colors' 

option at the bottom of the View tab of the Options dialog. 

 

Linked Colors 
Linked colors (that is ones tied to a parent, such as a tint or shade) are 

now represented differently on the color line (smaller rounded rectangles), so it's 

much easier to distinguish which are normal independent Named Colors and which 

are linked to a parent. 

 

  
 

Right Click on Color Line 
There is now a context menu that gives access to the most common color 

operations. 

  
Context sensitive right click menu on the color line 

You can restore the 

old right-click 

behaviour of setting 

the line color, using 

an option in the 

View tab of the 

Options dialog. 
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So the old right click to set line color has been removed. You can still Shift+Click to 

set a line color and this is now the recommended way to set line colors (or use right 

click and the menu option). 

  

Right clicking on the ‗no color‘ patch produces a slightly altered menu; with 'clear line 

color' and 'clear fill color'. 

 

  
Right click menu on the ‘no color’ patch 

 

Re-ordering Colors 
You can now just drag a Named Color on the color line to re-position it. 

 

Smart Line Coloring 
It was always confusing to new users why they could draw a simple line, click a color, 

and nothing happened (because that sets the fill color not the line color). So we‘ve 

made it smart and it can now detect whether the shape is open or closed. A left click 

will now set the line and fill color of an open path (i.e of an unfilled shape). 

Shift+Click can continue to be used as before. 

 

Bitmap Contoning 
If a bitmap or a bitmap filled shape is selected, then the right click context menu on 

the color line allows you set the contone colors as well as the line color. 
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Contone a photo by right clicking on the color line 

 

If a shape is filled with a bitmap (photo) then clicking on the color line will contone 

the shape filled with a bitmap (instead of converting it to a flat filled shape as it used 

to in older versions). So this is now consistent with the behavior of real bitmap 

objects. 

 

Fill Handling 

Adjusting fill positions 
As you know the single click-and-drag method of creating graduated fill and 

transparencies remains a key benefit of Xara Xtreme. We've now added the ability 

to push the fill (retaining the relative positions of the end points) within the shape. 

You can either just drag anywhere on the fill arrow - the whole arrow moves, or 

hold Shift while dragging anywhere on the fill.  So now with a single click-drag you 

can set the start, end and angle, and another click re-positions the fill as required. 

 

 
Move the fill by dragging on the fill arrow 

 

•  When dragging on the ends of the fill arrows (or transparency fill arrows) it now 

preserves the aspect ratio of the fill. Hold Shift to squash or skew the fill. 

•  It‘s now easier to find fill handles. In other words we've increased the hit radius 

when dragging near the ends of the fill arrows, making it less fiddly to adjust the 

ends. 
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Automatic Select Inside 
In the fill tool we‘ve made a significant change in that it now automatically selects 

shapes inside groups. This means it‘s significantly easier to view and edit the fill style 

of shapes. In the fill tool, just click on any shape, in a group or not, and it will select 

the shape and show the fill arrows (assuming it‘s not flat filled). Drags will now adjust 

the fill of that shape as usual. 

  

Combined with the new push fill feature, this means it‘s now significantly easier to 

manipulate fills of shapes. 

 

Vista Compatibility 

This release is now fully operational under Windows Vista e.g. it can be used from 

non-Admin accounts (on both Windows XP and Vista). 

 

Key Shortcut Changes 

•  Holding down space bar now does a temporary switch into the Push tool. 

Releasing it returns to the previous selected tool. Or, pressing it once will switch 

to the Push tool, pressing it again will return to the previous tool. 

•  Plain numeric 1, 2, 3, 4 set the zoom to be 100% to 400%.  Number 5 key sets it to 

be 50% (The old shortcuts on these keys have been moved to Ctrl+Shift+1, 2 etc) 

•  Ctrl+W closes the current document, as is becoming an industry standard 

shortcut. 

 

Some other recent key shortcut changes include: 

• Ctrl+Shift+R shows or hides the rulers 

• V selects the Selector tool 

• T selects the Text tool 

• Z selects the Zoom tool 

• G selects the Fill tool 

• H selects the Hand (push) tool 

• L selects the Ellipse tool 

• M selects the Rectangle tool 

• N selects the Freehand tool 

• W selects the Blend tool 

• Q applies ClipView to the selected objects 

• Alt+Q removes a ClipView 

 

There are a large number of new key shortcuts in the Text tool—detailed below. 
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Right Drag Copy 

Copying objects on your page is a very common operation when creating graphics, 

and Xtreme now makes this easier than ever before.  In the Selector tool if you 

right-drag (that is you hold the right mouse button, instead of holding the left mouse 

button while you drag) then the object will now be copied instead of moved. 

 

What‘s more, while dragging (with the right mouse button help down), each time 

you click the left button (requires slightly unusual mouse handling) a copy of the 

dragged object is dropped at each click.  

  

Easy Rotate 

To accompany the new easy ways of copying objects there‘s now an easier way to 

rotate objects without having to go into Rotate mode. 

  

Whereas before, you had to click on an object with the Selector tool to toggle 

between resize mode and rotate mode, now if you‘re in resize mode (the normal 

mode) if you hold the mouse-pointer just inside the corner selection handles (see 

illustration) then the pointer changes to indicate that dragging will now rotate 

instead of resize. 

 

 
 

So now you can resize and rotate all objects on the page without having to toggle 

between rotate and resize mode. 

 

The old method remains (i.e. clicking again to go into Rotate mode) or click the icon 

on the Selector tool InfoBar. 

 

 

 

 

You can still click 

on the Rotate icon 

on the Selector 

InfoBar. 
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New Templates 

A large collection of new top quality editable templates have been added,  including 

more greetings cards, newsletters and calendars, plus new categories such as photo 

albums and collages, newspapers, documents, certificates and coupons.  You can find 

them in the Clipart Gallery. 

 

 
Xtreme templates include cards, newsletters and photo albums 

 

 

Other Miscellaneous Changes 

Freehand Tool Change 
A small change is that the ‗hit radius‘ around the end of lines has been increased, 

meaning it‘s much easier to append lines to the end of others, and easier to draw 

closed shapes (so they will be filled with color). 

 

Editing Rounded Corner Rectangles 
Rounded corner rectangles can now be resized in the rectangle tool (including aspect 

ratio changes) while maintaining circular corners. Resizing in the Selector tool will 

still permanently transform the corners so they are not circular, as before. 

 

 
Retain rounded corners by  

resizing in the rectangle tool 

Click on the 

Clipart Gallery 

icon to access the 

resources in the 

ClipArt Gallery 

 

 
 

Click the ‘Get 

Clipart’ button to 

download some 

web-based clipart.  

examples. There 

is a much wider 

range included on 

the CD 
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Name Gallery Improvements 
The Name Gallery now shows more detail on the fonts used in a document, using 

the full font name as shown in the font gallery. It also shows variations of a font as a 

separate selectable font name, as well as the font family (e.g. "Arial Bold", "Arial 

Italic", "Arial Regular"). It shows at a glance which fonts have had to be synthesized 

and which are not installed. 

 

 
 

Print Dialog Improvements 
The Print dialog has been completely re-designed, the layout is now more intuitive. 
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Line Width 
Line width is now shown by default in pixels if the page unit is set to pixels. You can 

change this in the Units tab of the Options dialog (Ctrl+Shift+O). 

 

 

 

Animation Frame Gallery 
The Animation Frame Gallery order has been reversed, so it now shows the first 

frame at the top. 

 

 

Coordinate Direction 
You can now change the direction of page coordinates so that, for example, Y values 

increase as you go down the page. This is useful when you want the 0,0 point to be 

the top left corner and increase down the page like it does for HTML. These new 

options are on the Grid & Ruler tab of the Options dialog (Ctrl+Shift+O). 
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Document Info Dialog Improvements 
The Document Information dialog (File > Document Info) has been re-designed, the 

new layout is more intuitive. 

 

 
 

Other enhancements in V3.2: 
 There is improved support for accented characters, Unicode and non US 

keyboards 

 There is improved clipboard compatibility with MS Office and other 

applications - e.g. you can just copy and paste direct into Outlook and it 

embeds a JPEG 

 There is improved support for using Xtreme with multiple monitors 

 Dragging a file onto the title bar no longer opens MDI windows. 

 If you have MAGIX Photo Manager and have any photo edits saved for your 

photos (e.g. if you‘ve adjusted the brightness, contrast etc) then you can 

load the associated .jpx file and Xara will show the image with the correct 

processing. 

 

 

Errata 

For a list of errata in the Xara Xtreme manuals please visit: 

http://www.xara.com/support/xtreme/manual 

If you find an error or omission we would appreciate it if you inform us via the above 

URL. 

 

http://www.xara.com/support/xtreme/manual
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